£ ‘A‘,l_.- 3 \
S orD

Anekant Education Society’s
TULJARAM CHATURCHAND COLLEGE,
(Autonomous)

BARAMATI, DIST- PUNE - 413102

Proposed Syllabus
For

B. Voc. (Journalism and Mass Communication)
F.Y.B.Voc.- JM.C.

Under
National Skill Qualification Framework

(NSQF)

To be implemented from
2019-20




Title of the Programme: B. Voc. (Journalism and Mass Communication)
(To be implemented from Academic Year - 2019-2020)
Course structure:
e B.Voc. is three year programme with three general education courses and three skill
component courses in each semester.

e Each general education course will be of four credits and each credit is of 15 periods
e Each skill component course will be of six credits and each credit is of 15 periods
e Each period is of one clock hour.
e In each skill component course, there will be one visit to the relevant industry/ institute.
e In addition to the regular practical are based on the theory course, special emphasis will be on

communications and soft skills development of the students.

Eligibility:
1) First Year B. Voc. (Diploma): A student who has passed the Higher Secondary School
certificate (10+2) in any stream_or its equivalent examination.
2) Second Year B. Voc. (Advanced diploma): Keeping terms of First Year of B. Voc. and if
they fulfill the eligibility conditions.
3) Third Year B. Voc. (Degree): Student shall pass all First Year B. Voc. courses and

satisfactorily keeping terms of Second Year of B. Voc.

Note: Admissions will be given as per the selection procedure / policies adopted by the college, in

accordance with conditions laid down by the Savitribai Phule Pune University, Pune.

Examination Pattern:
Pattern of Examination: Semester:
e General education courses (Theory paper) - I, 11, 111, IV, V and VI Semester
e Skill Component (Practical Course): Practical examination will be conducted
e Weightage of marks in each course: Internal continues assessment (50%) and end

semester examination (50%)
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Anekant Education Society’s

TULJARAM CHATURCHAND COLLEGE, BARAMATI

Dist. -Pune-413102

B. Voc. Journalism and Mass Communication Syllabus Structure

First Year: Semester-I

Subj. Code Subject Name No. of Credits | Marks
General component
JM 101 Introduction to Mass Communication 4 100
JM 102 Introduction to Journalism 4 100
JM 103 Current Affairs- World, India, Maharashtra 4 100
Skill component
JM 104 Language skills- Marathi 6 150
JM 105 Computer Applications for Media 6 150
JM 106 Basics of photography 6 150
First Year: Semester-11
Subj. Code Subject Name No. of Credits | Marks
General component
JM 201 News reporting and Editing-I 4 100
JM 202 Writing for Media-1(Print) 4 100
JM 203 Indian Constitution 4 100
Skill component
JM 204 Language skills- English 6 150
JM 205 Feature Writing 6 150
JM 206 Photojournalism 6 150
Second Year: Semester-111
Subj. Code Subject Name No. of Credits | Marks
General component
JM 301 News reporting and Editing-II 4 100
Tuljaram Chaturchand College (Autonomous), Baramati. Page 3




JM 302 Writing for Media-I1(Broadcast & New Media) |4 100

JM 303 India After Independence 4 100

Skill component

JM 304 Editing Skills 6 150

JM 305 Film Appreciation 6 150

JM 306 Experimental Journal 6 150
Second Year: Semester-1V

Subj. Code Subject Name No. of Credits | Marks

General component

JM 401 Introduction to Television 4 100

JM 402 Introduction to Radio 4 100

JM 403 Indian Economics 4 100

Skill component

JM 404 Radio Production 6 150

JM 405 Television Production 6 150

JM 406 Basics of Video production 6 150
Third Year: Semester-V

Subj. Code Subject Name No. of Credits Marks

General component

JM 501 New Media 4 100

JM 502 Introduction to Media Research 4 100

JM 503 Public Relations 4 100

Skill component

JM 504 New Media 6 150

JM 505 Video Production Group Project 10 250

JM 506 Industry Internship 2 50

Tuljaram Chaturchand College (Autonomous), Baramati.

Page 4




Third Year: Semester-VI

Subj. Code | Subject Name No. of Credits Marks

General component

JM 601 Basics to Advertising 4 100

JM 602 Development Communication 4 100

JM 603 Media, Culture & Society 4 100

Skill component

JM 604 Designing and Analysis of Ads 6 150

JM 605 Dissertation/In-depth reporting (IDR) 10 250

JM 606 Industry Internship 2 50
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First Year Semester |
Introduction to Mass Communication

Theory Paper No. JM 101
Maximum Marks: 100 Credits: 4
Teaching Period: 4 /week Teaching Load: 60 Theory Period/Semester

Unit 1. Development of Communication
Why do we communicate?
Development of Human communication
Meaning & Elements/components of human communications;
Concept of Communication

Unit 2- Communication
Communication as a social, human & universal process.
Factors responsible for growing importance of Communication,
Effective communication & its Barriers.
The seven C’s of Communication,

Unit 3. Process of Communication:
Transmission of ideas, Facts & feelings
Elements of Communication process
Noise and feedback in communication

Unit 4. Verbal Communication
Universals of Verbal Communication
Meaning & Barriers in Verbal Communication
Language, Sub-Language & Culture
Elements of speech communication

Unit 5. Non-Verbal Communication
Non-Verbal behaviour as communication
Body communication-Body movement, Facial Communication
Space Communication-Physical environment
Silence, Paralanguage & Temporal communication

Unit 6. Forms of Communication:
Intra Personal Communication
Interpersonal Communication
Group Communication (Public, Crowd, Small Group)
Mass Communication

Unit 7. Communication models and models
Basic communication models
Basic communication theories
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Campaign and propaganda- the case of politics
Agenda setting, Cultivation, Diffusion

Unit 8. The Rise of Mass Communication:
Concept of ‘Mediation', 'Mass' and 'Mass Society'
Process and characteristics ‘Mass Communication’,
Modernity and mass communication
Media, culture and society

SUGGESTED READINGS :

1) McQuail, Denis. McQuail's Mass Communication Theory. (2000). London: Sage.

3) Defleur M. L. Everette, Dannis, understanding, Mass-Communication Goyal Sa, New Delhi -
1991.

7) Kumar Keval J., Mass Communication in India, Jayco, 2001.

8) Malhan P. V. Communication Media Yesterday, Today & Tommorrow, Publication Div., New
Delhi., 1985.

9) McLuhan Marshall understanding Media Rutledge & Kegan Paul, , 1964.

10) Schramm Wilbur, Mass Communication, University, J Illinois, 1960.

11) Schramm Wilbur, the Process and effects of Mass Communication, Uty &Illinois, 1965.

12) Dr. Pawar Sudhakar, Sanvad Shastra, Mansamman Prakashan, Pune
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First Year Semester |
Introduction to Journalism

Theory Paper No. - JM 102

Maximum Marks: 100 Credits: 4

Teaching Period: 4 /week Teaching Load: 60 Theory Period
CONTENT

Unit 1:Beginning of the Press in India
« Beginning of the Press in India: Technological development,
» Invention of printing and movable type in Europe,
« Early Anglo-Indian newspapers, Hicky’s Gazette, Buckingham’s Journal,
» Social reform movement and journalism- Raja Ram Mohan Roy, etc.

Unit 2:National leaders and newspapers
 Driving force of the freedom struggle (1885 to 1947): National leaders and newspapers,
» Tilak (Kesari, Maratha), Surendranath Banerjee, Mahatma Gandhi (Harijan),
« Ghose brothers (Amrut Bazar Patrika), Benjamin Horniman (Bombay Chronicle),
+ Kasturi Ranga (The Hindu), Lala Lajpat Rai, Jawaharlal Nehru,
S. Sadanand (Free Press Journal), Robert Knight (Times of India, Statesman), etc.

Unit 3:Role of the language press

* Role of the language press with emphasis on Marathi newspapers and editors:

« Bal Shastri Jambhekar, Lokhitwadi, Ranade, Tilak, Agarkar, N. C. Kelkar, S. M. Paranjape,
Kolhatkar, Dr. Babasaheb Ambedkar, Khadilkar, Acharya Atre, Nanasaheb Parulekar, etc.;

« Some significant Marathi Newspapers: Darpan, Prabhakar, Sandesh, Dnyanprakash,
Kesari, Kal, Bahishkrut Bharat, Prabhat, Sakal, Loksatta, Maharastra Times, Lokmat, Pudhari
etc.; Status of district newspapers, changing face of Marathi newspapers

+ Hindi Journalism: beginning, growth, contribution; prominent Hindi journalists.

Unit 4:Emergence of the fourth estate
« Emergence of the fourth estate: Development of news agencies,
* Changing role and nature of the press, government’s newsprint policy
« Emergency and the press, Role and reports of press commissions
» Current trends in English and language journalism in India

Unit-5:Indian Press
« National Press, Regional Press, District and Tehsel Level Press
« Electronic Medium and Internet Journalism,
» Representative Newspapers and Magazines (Anand Bazar Patrika,Enadu, Navbharat Times
» Jansatta, Malayalam Manorama, Nai Dunia, Bhaskar, Aaj Punjab Kesari, Kaumi Awaz,
Sakaal, Hindu, Times of India, Dinman.

Unit-6: Introduction to printing industry in India
« Brief History, Latest development.
« Introduction to major specialized magazines .
* News magazines, Women’s magazines, Sports magazines,
» Business magazines, Health magazines, IT magazines

Unit-7: News Agencies
« Major news agencies: Reuters, AP, AFP, UNI, PTI, ANI.
» Role and importance of news agencies.
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» Functioning of news agencies.

Unit 8:Changing Indian Media scenario
« Changing Indian Media scenario: Advent of electronic and online media
» Challenges before print media and its response
« New technology in Indian media, changing media management
* Globalization and foreign investment; Complex social life and media

Suggested reading:

1. Mitra, Mohit and Sunil Basu. A History of Indian Journalism.

2. Murthy, N.K. Indian Journalism,

3. Miller, Carl G. and others. Modern Journalism.

AR, .., AT FAOATET SMAEM, Fifreded THTAT

5. Parvate, T.V. Marathi Journalism.

6. Padhy, Dr. Krushna Singh. The Indian Press: Role and Responsibility.

7. Rau, Chalapthi. The Press. National Book Trust.

8. Madhavrao L .R. Assessing the Trends in Journalism. Sumit Enterprises, 2004.

9.Journalism In India : History * Growth ¢ Development by Jai Narain Sharma (Author), K. C.
Sharma (Author)

10.Print Journalism: A Complete Book of Journalism by Charanjit Ahuja (Author), Bharat Hiteshi
(Author)

11.marazl p~kairta pihlal pavalao : p a.sau.h.jaaoSal

First Year Semester |
Current Affairs- World, India, Maharashtra

Theory Paper No. JM 103

Maximum Marks: 100 Credits: 4

Teaching Period: 4/week Teaching Load: 60 Theory Period/Semester

Unit-1: Economical scenario of world
» Current global economic situation
« World economic situation and prospect
« Economy reports and surveys
e Current news on economic scenario

Unit-2: Economical scenario of India and Maharashtra
« Indian economic growth rate and statistics,

* Information About Maharashtra: Industries, Exports, Aguricaltuar
» Economy survey of Maharashtra.

Unit-3: Political scenario of world
« World Politics Review
« Latest news on political scenario
« Global political issues

Unit-4: Political scenario of India and Maharashtra
« Politics of India,
» Present political condition.
« Politics of Maharashtra
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https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=2&cad=rja&uact=8&ved=2ahUKEwjVg_TT-8fhAhVCzmEKHT5lCzsQFjABegQIABAB&url=https%3A%2F%2Fwww.ibef.org%2Fstates%2Fmaharashtra.aspx&usg=AOvVaw3mbgQullH5B2YOysBSW1RK
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=2&cad=rja&uact=8&ved=2ahUKEwjVg_TT-8fhAhVCzmEKHT5lCzsQFjABegQIABAB&url=https%3A%2F%2Fwww.ibef.org%2Fstates%2Fmaharashtra.aspx&usg=AOvVaw3mbgQullH5B2YOysBSW1RK
https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=2&cad=rja&uact=8&ved=2ahUKEwjVg_TT-8fhAhVCzmEKHT5lCzsQFjABegQIABAB&url=https%3A%2F%2Fwww.ibef.org%2Fstates%2Fmaharashtra.aspx&usg=AOvVaw3mbgQullH5B2YOysBSW1RK

» Latest news on India and Maharashtra politics.

Unit-5: Regional issues in India
« Shaming ,Intolerance — Everything From Religion And Art To Personal Choices,
* Air, Sound And Water Pollution, Hygiene And Sanitation, Women’s Safety, Poverty in India
« Population Stabilization, Climate Change, Renewable Energy — Solar Energy
* A Terrible Mistake: Equating ‘“Dharma” with “Religion, disparities in India and human
development.

Unit 6: Social issues in India and Maharashtra
« Social Problems: Conceptual understanding, Illiteracy, Poverty,
» Unemployment and Population Growth. Child Abuse,
« Child Labour and Violence against Women.
» Casteism, Communalism, Regionalism and Language Conflicts. Crime, Criminal,
Criminology and Juvenile Delinquency. Alcoholism, Drug Abuse and Corruption.

Unit 7 : Agricultural issues in India and Maharashtra:
« Small and fragmented land-holdings, Seeds, Manures,
 Fertilizers and Biocides, Irrigation, Lack of mechanization ,
« Soil erosion, Inadequate storage facilities,
 Inadequate transport, Scarcity of capital.
Unit-8: Security issues of India, Terrorism, Nasalized movements

« Traditional and Non traditional issues.
« History of Terrorism, Foreign terrorist originations,

* Terrorism in India, Terror group in India, Naxial movement in India, Maoist,
« Naxalism: grounds, ideology and power.

Suggested reading:

Current affairs magazines

India today

Frontline

The Caravan

Economical and Political weekly

Daily Newspapers.
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First Year Semester |
Language skills- Marathi

PRACTICAL Paper No. JM 104
Maximum Marks: 150 Credits: 6
Teaching Period: 2/week Teaching Load: 30 Practical/Semester (4 Period each)

Unit 1- Vocabulary: Active and passive vocabulary, Importance of short & plain words, Choosing
the right/precise word from words having similar meanings, Ways of expanding one's active
vocabulary, Levels of vocabulary usage: formal & informal, spoken & written.

Unit 2- Sentence: Definition, Subject & Predicate, Functions of words used in a sentence,
Importance of the verb in sentence, Unity, Lucidity, Various relations between sentences,
Connectors, Types of sentences: Active & Passive, Simple, Complex, Compound, Statements
(Positive/Negative), Imperative, Interrogative, Exclamatory. Need to vary the type & length of
sentence.

Unit 3- Paragraph: Principles of organizing & developing a paragraph, Topic sentence, Argument-
Counter argument, Explanation & illustration, Reiteration, Variation of length, Unity.

Unit 4- Punctuation: Comma, Semicolon, Colon, Full stop, Question mark, Exclamation mark,
Hyphen & Dash, Brackets (round, square) and their sequencing, Parenthesis, Capitals, Apostrophe,
Quotation marks, Ellipsis.

Unit 5-Types of writing: Essay, Feature, Business Letter, Editorial comment.

Unit 6- Critical Reading: Analyzing the choice of vocabulary, the sentence structure, the sentence
connectors, the structure of paragraphs and the stylistic features; checking the material for simplicity
and precision of expression of the intended meaning.

Unit 7- Spoken language: pronunciation, intonation, inflection, stress

Unit 8- Listening skills: Comprehension through listening, listening to various programs and
analyzing them for their language and presentation

Unit 9-Translation: basics of translation, precautions to be taken, different types of translations.

Unit 10-Writing skill: Review of book, drama, summarizing.
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First Year Semester |

Computer Applications for Media

PRACTICAL Paper No. JM 105
Maximum Marks: 150 Credits: 6
Teaching Period: 2/week Teaching Load: 30 Practical/Semester (4 Period each)

1. Introducing Computer and Operating system

2. MS-WORD

3. MS-EXCEL

4. MS-POWERPOINT

5. Introduction to the internet, search engine

6. E-Mails, Google Docs and Forms

7. Introduction to Pagemaker

8. Introduction to Corel Draw

9. Introduction to Photoshop

10. Web development: HTML and Scripting language

References:

1) Microsoft Office 2000 by Vipra Computers, Vipra printers pvt. Ltd.
2) Advanced Maicrosoft Office 2000 by Mereditha Flynin, Nita Rukosky, BPB pub.
3) Teach yourself Windows

4) Fundaments of Computers - V. Rajaraman
5) Computer Fundamentals by P. K. Sinha & Priti Sinha, 4th edition, BPB, publication.
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First Year Semester |
Basics of photography

PRACTICAL Paper No. JM 106
Maximum Marks: 150 Credits: 6
Teaching Period: 2/week Teaching Load: 30 Practical/Semester (4 Period each)

1- Evolution of camera
2- Types of camera
3- Internal structure and working
4- Key concepts
« Brightness

» Contrast

« Sharpness
« Blur

« Color

» Size

5- Camera controls
« Camera controls introduction

» Aperture
e Shutter
« ISO

« Operations
6- Camera modes
* Auto mode
» Manual mode
»  Other programmed mode
» Silhouette
« Night mode
7- Camera lenses
« Types of lenses
« Importance of lenses
« Composition
« Comparison
« Focusing
8- Rules of composition and framing
9- Lightin photography
10- Types of photography
11- Black and white photography
12- Introduction to Photo editing
13- Resizing and cropping images
14- Working with basic selection tools
15- Photo retouching and color correction
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First Year Semester |1
News Reporting and Editing-I

Theory Paper No. JM 201
Maximum Marks: 100 Credits: 4
Teaching Period: 4/week Teaching Load: 60 Theory Period/Semester

Unit 1- Understanding news
« Definitions, purpose and importance of news.
» Qualities of news accuracy.
+ Clarity, objectivity, balance, directness, etc.;
» Media-specific nature of news: cross platform discussion.

Unit 2- News Reporter
« Categories: staff reporter, stringer, correspondent, chief reporter, principal correspondent,
bureau chief, foreign correspondent
« Their functions and responsibilities
« Qualities of a news reporter
» Rights and responsibilities

Unit 3- Evaluating news
» News sense and news values,5 Ws and H,
« Importance of ‘what next?",
« Changing concepts: readers, relationship, relevance and utility,
* News beats: introduction beat mapping.

Unit 4- News gathering and Sources
+ Basic tools for information gathering: maintaining a diary, taking notes
« Use of computer, internet, mobile and other gadgets, using maps, history and archives;
* Right to information: Concept, provisions, how to use it
» Cultivating the sources: Why and how?, reliability, checking information from various
sources, pressures and pulls

Unit 5- Editing
« Editing: concept, process and significance ,
« Editorial Values: objectivity, facts, impartiality and balance ,
« Concept of news and news making ,
» Challenges before editor : bias, slants and pressures

Unit 6- News Desk
 Editorial structure of newspaper/magazines/ news agencies,
 Editorial hierarchy and job of various functionaries ,
» Functioning of news desk ,Newsroom ,
» News Flow and Editing: Role and Responsibility of Gatekeepers ,Sources of News Managing
the news flow.

Unit 7- Editing Process
* News selection: News Value and other parameters ,Handlin of news copy ,
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« Planning and visualization of news ,Rewriting news stories ,
» Headlines and intro ,Kinds of headlines: banner, sky line etc.
» Stylebook and Style sheet ,Use of synonyms and abbreviations.

Unlt 8 - Newspaper Design
Structure of newspaper, broadsheet, tabloid and Berliner size,
 Principles of Layout & Design
« Types of Layout, Typography, color and Graphic,
» Newspaper Printing Process and printing terminology.

Suggested reading:
1. FTARUT TH.%, 2004 TARIAT AEGH, qOF @R I8 T

2. AT "TeT, 2018, aTaHtERT

3. Lewis James. The Active Reporter. Vikas Publication

4. Warren Carl. Modern News Reporting. Harper and Row.

5. Rangaswami, Parthasarathy. Basic Journalism. Macmillan India.

6. Charnley V. Mitchell. Reporting (4th Ed.). Holt, Rinehart and Winston.
7. Mudgal, Rahul. Emerging Trends in Journalism. Sarup and Sons.
8
9

. Kamath, M.V. Behind The By-Line. Vision Books.
. Kamath, M.V. Reporter at Large.
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First Year Semester |1
Writing for the Media-I

Theory Paper No. - JM 202

Maximum Marks: 100 Credits: 4

Teaching Period: 4 /week Teaching Load: 60 Theory Period
CONTENT

1) Introduction to writing Skills
e Different forms of writing
e Elements of Good Writing
e Searching ideas and nurturing them
e Writing CV’s and minutes

2) Study SkKills
e Memorizing Vs Internalizing
e Reading Skills: Skimming and Scanning Skills
e Non-linear Study methods
Thinking: Vertical and lateral,
e Lateral thinking in practice

3) ICT Skills
e Microsoft Office: Word, Excel, PowerPoint
e File Transfer and Sharing Resources
e Internet application: Email, important Websites
e Social Networks: use and application

4) Communication Skills
e Interpersonal Communication
e Group Communication
e Interview Skills
e Communication with Special Group

5) News Writing

Styles of News writing
Structure of News

Writing Intro/Lead, Body
Different types of Intro/Lead

6) Qualities of news writing
e Organizing the News Story: Angle, Attribution, Quote, Background & Context
e Accuracy, Objectivity, Fairness and Balance
e Writing Headlines
o Types of news: soft news and hard news

7) Types of Journalistic Writing

e+ [eatures: Idea, Process,
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e Writing Style and Packaging
e+ Opinion Writing: Editorial, Article, Commentary
e« \Writing for News Magazines

8) Writing for media environment

e Conventions and practices
e writing for an audience, development; transitions
e Writing assignments, leads, short news

Recommended Readings:
1. Richard, Communication Skills
2. A.E. Schwartz, Communication Skills
3. Leena Sen, Communication Skills
4. John Niles on, Communication Skills
5. Juluis, Fast Body Language
6. Feature Writing- a Practical introduction- Susan Pape, SAGE Publications
7. Brendan Hennessy, Writing Feature Articles,4" edition, focal press

8. I HTBT, ATAHIRTLN,2,3, TSTed THTAT
9, TAAFHTL AFASHT, FHAT TIENT, TTd THIAT
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First Year Semester 11
Indian Constitution

Theory Paper No. JM 203

Maximum Marks: 100 Credits: 4

Teaching Period: 4/week Teaching Load: 60 Theory Period/Semester
CONTENT

Unit-1 Indian Constitution
 Inspirational sources for Indian constitution
 Indian Constitution making process
» Salient Features
» Preamble of Indian Constitution

Unit-11 Features
« Fundamental Rights
» Fundamental duties.
« Directive Principles
« Correlation between Fundamental Rights and Directive Principles

Unit-111 Indian States & Union Territories
» States
* Union Territories
« Centre-State Relations
« Directive Principles of state policy.

Unit-1V: Power and functioning of Central Government
« Parliament
» President Election and power
* Vice President: Election and power
« Prime Minister and the cabinet

Unit-V: Power and functioning of State Government
» Chief Minister and the cabinet
« Parliament — Functions and powers
» Governor: Power & functions
 Politics at the district level — Panchayat raj, Elections and governance

Unit-VI: -Judicial System
+ State legislature — Functions and powers
« Superior Judiciary - Supreme Court,
» High Courts
» Subordinate Judiciary

Unit-VII: -Party System
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« Multi-Party System

« National Parties and their history
» Regional Parties

» Presser Groups

Unit-VIII: Electoral System
« Election Commission — Functions and powers
» General Elections, Mid-Term Elections, By Elections
« Elections of upper and lower houses
 Election of President and Vice President

SUGGESTED READING :
Indian polity by Laxmikanth
Indian Administration by Subhash Kashyap
Indian Constitution by D.D. Basu
Indian Administration by Avasti and Avasti
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First Year Semester 11
Language skills- English

PRACTICAL Paper No. JM 204
Maximum Marks: 150 Credits: 6
Teaching Period: 2/weak Teaching Load: 30 Practical/Semester (4 Period each)

Content

Unit 1 Fluency in Grammar Usage

1) Tenses

2) Verbs

3) Active & Passive Voice

4) Reported Speech

5) Prepositions

6) Conjunctions

7) Effective Sentence-Construction

8) Vocabulary

Unit 2 Fundamentals

1) Greeting and taking leave

2) Introducing yourself

3) Introducing people to one another

4) Making requests and asking for directions
5) Congratulating, expressing sympathy and offering condolence
6) Making suggestions and offering advice
7) Making and accepting an apology

Unit 3 Situational dialogues

Unit 4 Personality development

Unit 5 Interview and Group discussion
Unit 6 Writing and comprehension skills
1) Letter (Formal) and Email

2) Report

3) Summarizing reports, articles, editorials
4) Making an abstract

5) Review writing

6) Writing resume

First Year Semester |1
Feature writing- |
PRACTICAL Paper No. JM 205
Maximum Marks: 150 Credits: 6
Teaching Period: 2/weak Teaching Load: 30Practical/Semester(4 Period each)
Content

1) Computer typing techniques
e Understanding In script font
e Marathi, English typing
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e Page Setup

2) Feature writing starting Point
e writing on local Issues
e Write about your favourite sports
e  Write about your home town

3) Human interest stories
e Visit nearby old age home and write about your experience
e Visit nearby Orphanage and write about your experience
e Write any government office and write report

4) Feature Writing for Newspaper
e Human interest stories, backgrounders
e Op-ed articles, Editorials
e Articles, Middles, Columns
5) Writing across media
e Writing for news magazines
e Writing for blogs
e Writing for mobile
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First Year Semester 11
Photojournalism-I

PRACTICAL Paper No. JM 206
Maximum Marks: 150 Credits: 6
Teaching Period: 2/week Teaching Load: 30 Practical/Semester (4 Period each)

1- History of photojournalism

2- Role of photojournalists in a newsroom.

3- Principles and Ethics of photojournalism.

4- Reading the mistakes in photos (noise in photographs, over exposure etc.)
5- Caption Writing, Management of photographs and Digital archives.
6- Spot News, general news photography

7- Street Photography, off-beat photography

8- Documentary photography

9- War, terror, and crime

10- Photographs for photo features

11- Photo stories

12- Photo essays

13- Developing specializations

14- Group photo feature

15- Individual Documentary photography Project

*hhkkkhkhkhkkhkhkhkkhhkhkkhhkhkkhhhkrhhkkhhhkhhhkhhhkhhhkhhhkhkkhhkhkkhhkhkhhkhkihkhkirhhkirhhkkihhkihhkhhhkkihikkihiikiik
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Anekant Education Society’s
TULJARAM CHATURCHAND COLLEGE,
(Autonomous)

BARAMATI, DIST- PUNE -413102

Proposed Syllabus
For

M. VVoc. Media Studies
F.Y. M. Voc. M.S.

Under
National Skill Qualification

Framework (NSQF)

To be implemented from
2019-20
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Title of the Course: M. Voc. Media Studies

(To be implemented from Academic Year - 2019-2020)
Course structure:

e M.Voc. is two year post graduate programme with fourgeneral education courses and
threeskill components courses in each semester.

e Each general education course will be of three credits and each credit is of 15 periods.

e Each skill component course will be of six credits and each credit is of 15 periods

e Each period is of one clock hour.

e In each skill component course there will be one visit to the relevant industry/ institute.

e This M.Voc. Programme offers two specializations from third semester namely Digital
Journalism and Video Production.

e In addition to the regular practical are based on the theory course, special emphasis will be on

communications and soft skills development of the students.

Eligibility:
1) First Year M.Voc. (Post Graduate Diploma): A student who has passed the graduation

degree (10+2+3) in any streamor its equivalent examination.

2) Second Year M.Voc. (Post Graduate Degree): Satisfactorily keeping terms of First Year of
M. Voc. and if they fulfill the eligibility conditions.

Note: Admissions will be given as per the selection procedure / policies adopted by the college, in

accordance with conditions laid down by the Savitribhai Phule Pune University, Pune.

Examination Pattern:
Pattern of Examination: Semester:
e General education courses (Theory paper) - I, 11, 111, and IV Semester
e Skill Component (Practical Course): Practical examination will be conducted
e Weightage of marks in each course: Internal continues assessment (50%) and end

semester examination (50%)
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Anekant Education Society’s

TULJARAM CHATURCHAND COLLEGE, (Autonomous) BARAMATI

Dist. — Pune-413102

M. Voc. Media Studies Syllabus Structure

Subject Code | Subject Name \ Credits | Marks
Semester |
General Education
MS 101 Introduction to Media Studies Credits 04 100
MS 102 Introduction to Journalism Credits 04 100
MS 103 Introduction to video production Credits 04 100
Skill Component
MS 104 Writing for Media Credits 06 150
MS 105 Photography Credits 04 100
MS 106 Introduction to Media Software Credits 04 100
MS 107 Camera Techniques- | Credits 04 100
Semester |1
General Education
MS 201 Visual Communication Credits 04 100
MS 202 Media, Society and Culture Credits 04 100
MS 203 Media Research Methods Credits 04 100
Skill Component
MS 204 Camera Techniques- Il Credits 06 150
MS 205 Experimental Journal Credits 04 100
MS 206 Script Writing Credits 04 100
MS 207 Anchoring skills and Voice Modulation Credits 04 100
Semester 111 - Video Production
General Education
MS 301A Script Writing and Direction Credits 04 100
MS 302A Sound and Post-production Credits 04 100
MS 303A Film Appreciation Credits 04 100
Skill Component
MS 304A Group Project Credits 06 150
MS 305A Video Editing Credits 06 150
MS 306A Lighting Techniques Credits 06 150
Semester 111 — Digital Journalism
General Education
MS 301B Advertising Credits 04 100
MS 302B New Media Studies Credits 04 100
MS 303B Broadcast Journalism Credits 04 100
Skill Component
MS 304B Group Project Credits 06 150
MS 305B Audio Production Credits 06 150
MS 306B Digital Content Development-I Credits 06 150
Semester V- Video Production
General Education
MS 401A Production Management Credits 4 100
MS 402A Marketing and Promotion Credits 4 100
MS 403 Media Audience Credits 4 100
Skill Component
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MS 404A Production Project Credits 10 250
MS 405A Animation and Special Effects Credits 4 100
MS 406A Internship/ Study Visit Report Credits 4 100
Semester IV - Digital Journalism

General Education

MS 401B Brand Management Credits 4 100
MS 402B Social Media Marketing Credits 4 100
MS 403 Media Audience Credits 4 100
Skill Component

MS 404B In-depth Reporting/ Dissertation Credits 10 250
MS 405B Digital Content Development-1I Credits 4 100
MS 406B Internship/ Study Visit Report Credits 4 100
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First Year Semester |

INTRODUCTION TO MEDIA STUDIES

General education Paper No. - MS 101

Maximum Marks: 100 Credits: 4

Teaching Period: 4/week Teaching Load: 60 Theory Period
CONTENT

Unit 1: Revisiting the World of Communication
» Centrality of Communication in the Living World
» Communication as Site of Culture
» Communication a Site of Social Relations
« Communication and Technology
Unit 2: Types and Forms of Communication
» Types on the Basis of Number of Participants
« Types on the Basis of Medium
« Types on the Basis of Purpose
« Forms of Communication-Verbal/Non Verbal, Visual/ Olfactory
Unit 3: Academic Study of Communication
« Evolution of Academic Discipline of Communication Studies
» Process and Semiotic Perspectives
« Basic Communication Models: Shannon & Weaver, Gerbner, Osgood, Newcomb
+ Indian Perspectives on Communication
Unit 4: Introduction to Semiotic Perspective
« Goals of Semiotic Analysis
« Sign: Concept and Types
« Codes: Concepts, Types and Sharing
» Process of Signification: Connotation and Denotation
Unit 5: Semiotic Interpretations and Culture
« Metaphors
» Myths: Concept and Debates
« Communication as Text/Discourse
» ldeology: Link to Meaning Making
Unit 6: Introduction to Rhetoric Perspective
+ Origin and Evolution
» Functions of Rhetoric
» Key Elements of Rhetoric
* Introduction to Indian Thoughts on Rhetoric
Unit 7: Rhetoric Presentation and Effects
* Rhetorical Schemes and Devices
» Elements of Rhetoric Presentation
* Analyzing Rhetorical Presentation
« Making Rhetorical Presentation
Unit 8: Massification and Evolution of Mass Communication
» The Process of Massification and Rise of Mass Society
» Mass Communication as Political and Economic Need
» Mass Communication as Cultural Expression
» Technological Phases of Media of Mass Communication

Recommended Readings:

1. Lewis, J. (2002).Cultural studies: The basics. London: SAGE Publications.

2. Kumar. K.J.(2000).Mass communication in India. Mumbai: Jaico Pub. House
3. Watson. J. (1985).What is communication studies? London: Edward Arnold.

Tuljaram Chaturchand College (Autonomous), Baramati. Page 28



4. Berko Roy (1989) Basically Communicating. Wm. C. Brown Publishers,312 pages

5. Roloff. M. E. & Miller. G. R.(1987) Interpersonal processes: New directions in communication
research. Newbury Park.Calif: Sage Publications.

6. Carey, J. W. (1989).Communication as culture: Essays on media and society. Boston: Unwin
Hyman.

7. Ghanekar, A (1998)Communication skill for effective management. Everest Publishing House.
Gilligan, Pune.

8. Fiske, J. (1982).Introduction to communication studies .London, Angleterre: Methuen.

9. Schlenker, B. R. (1980).Impression management: The self-concept, social identity, and
Interpersonal relations. Monterey, Calif: Brooks/Cole Pub. Co.
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First Year Semester |
INTRODUCTION TO JOURNALISM

General education Paper No. - MS 102

Maximum Marks: 75 Credits: 4

Teaching Period: 3/week Teaching Load: 45 Theory Period
CONTENT

Unit 1: Origin and Growth of the Press in India
» Advent of Printing Press in India and Newspaper
« Role of the Press in India’s social awakening in 19" century
* Role of the Press in India’s Freedom Movement
« Historical Development of the Press as a media Institution in India.

Unit 2: Journalism
» Concepts, dimensions and functions of journalism.
« Nature of the media and content: Print, electronic and online newspapers.
» Journalism as a profession: role and responsibilities and challenges;objectivity and fairness.
« Careers in journalism. Indian society —demography, socio-economic & political profile and
the responsibility of the press.

Unit 3: Contemporary Indian Press
« Study of leading newspapers and journalists in India since 1947
» The vernacular Press in India with reference to the Hindi language Press
« Development of news agencies
« Contemporary development in Indian Press, vis-a-vis other media .

Unit 4 - Major news agencies
« Reuters, AP, AFP, UNI, PTI, ANI,
* Role and importance of news agencies
« Functioning of news agencies

Unit 5 -Different forms of print-
» A historical Perspective Yellow journalism Penny press,
» Broadsheet, Berliner tabloid press,
» Book, Newspaper, Magazine
« Language of news- Robert Gunning: Principles of clear writing

Unit 6: Indian Constitution and Press Laws
« Main features of the Indian Constitution
* Rights, privileges and liabilities of the press; parliamentary privileges
« Contempt of court
« Important Acts and laws on press

Unit 7 : Role of Media
* Role of Media in a Democracy
» Responsibility to Society
* Press and Democracy
« Contemporary debates and issues relating to media Ethics in journalism

Unit 8: Indian Journalism in New Era
« Social media and e-Journalism
« Mapping the News App Ecosystem
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» Marginalization and Journalism

» Ethics, Pedagogy, and the Public Sphere in Journalism
Suggested Readings: -
Bruce D. Itule and Douglas A. Anderson.News writing and reporting for today’s media; McGraw
Hill Publication, 2000.
M.L. Stein, Susan Paterno& R. Christopher Burnett. News writer’s Handbook: An Introduction to
Journalism; Blackwell Publishing,2006.
George Rodmann. Mass Media in a Changing World; Mcgraw Hill Publication,2007.
Carole Flemming and Emma Hemmingway. An Introduction to Journalism; Vistaar
Publications,2006.
Richard Keeble. The Newspaper’s Handbook; Routledge Publication,2006.

Indian Journalism in a New Era ,Changes, Challenges, and Perspectives ,Shakuntala Rao; Oxford
University Press, 2019
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First Year Semester |
INTRODUCTION TO VIDEO PRODUCTION

General education Paper No. - MS 103

Maximum Marks: 100 Credits: 4

Teaching Period: 4/week Teaching Load: 60 Theory Period
CONTENT

Unit 1: Moving Image Dynamics
« Still and Moving Image Comparison
» Elements of Moving Image
« Technical Aspects of Moving Image
» A brief history of moving image: Film to Video

Unit 2: Image and Sound Combination
+ Basic Physics of Sound
+ Cultural Elements of Sound
» Image and Sound Synchronization
« Technical Aspects of Audio-Visual Combination

Unit 3: Visual Composition
» Elements of Shot Composition
« Scene and Sequences
« Elements of Writing for Visual medium
» Time and Space Dimensions

Unit 4: Screen Grammar and Genres
« Camera Angles
« Continuity
« Transitions: Cuts, Wipes etc
» Basic TV Genres

Unit 5: Production Process I- From Idea to Screen
 ldea: Feasibility and Research
» Pre-production: Script Development, production planning
e Production Work
» Post Production Process

Unit 6: Production Process I1- People and Work
« Creative Personnel- Director, Script Writer
« Technical Personnel- Camera, Lights, Makeup, Choreographer, Sound Recordist, Music
Director, Graphic Designer, Editor
« Team Work
« Elements of Production Management

Unit 7: Production Equipment and Technology
« Camera Types and Functions
» Lighting Equipments
« Sound Equipments
« Editing Equipments

Unit 8: Management and Distribution of Video
« Studio Based and Outdoor
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» Funding and Accounting

e Permissions and Administration

« Various Platforms of Video Distribution
e Promotion

Recommended Readings:

1. Monaco, J. (1981). How to read a film: The art, technology, language, history, and theory of film
and media. New York: Oxford University Press

2. Millerson, G., & Owens, J. (2012). Television Production. Burlington: Elsevier Science.

3. Burrows, T. D., & Wood, D. N. (1986). Television production: Disciplines and techniques.
Dubuque, lowa: W.C. Brown.

4. White, G. (1982). Video techniques. London: Newnes Technical Books

5. Peter. Combs and John Tiffin(1978). TV production for Education.Focal Press.196 pages.

6. Richard .Lindheim. (1991) Inside TV Producing.Focal Press.328 pages.

7. Harcourt, A. (1986). The Independent producer: Film and television. London: Faber and Faber.
8. Kindem, G. A., &Musburger, R. B. (1997). Introduction to media production: From analog to
digital. Boston: Focal Press.

9. Fairweather, R. (1998). Basic studio directing. Oxford: Focal Press.

10. Rowlands, A., &Rowlands, A. (1994). The continuity handbook: A guide for single-camera
shooting. Oxford: Focal Press.

11. Owens, J., &Millerson, G. (2012). Video production handbook. Burlington, MA: Focal Press.
12. Ferncase, R. K. (1995). Film and video lighting terms and concepts. Boston: Focal Press
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First Year
Writing for Media

General education
Maximum Marks: 150 Credits: 6
Teaching Period: 2/week

CONTENT

1) Introduction to writing Skills
+ Different forms of writing
» Elements of Good Writing
+ Searching ideas and nurturing them
*  Writing CV’s and minutes
2) Study Skills
* Memorizing Vs Internalizing
» Reading Skills: Skimming and Scanning Skills
* Non linear Study methods
« Thinking: Vertical and lateral, Lateral thinking in practice
3) ICT Skills
» Microsoft Office: Word, Excel, Power Point
« File Transfer and Sharing Resources
 Internet application: Email, important Websites
» Social Networks: use and application
4) Communication SkKills
* Interpersonal Communication
«  Group Communication
* Interview Skills
«  Communication with Special Group
5) Writing for media environment
« Conventions and practices
«  Writing for an audience, development; transitions
» Writing assignments, leads, short news

6) Writing for Print
News sense and news values
News lead, Body of News
Feature Writing
Types of feature

7) Writing for broadcasting media
TV writing style
Writing for TV news
Radio writing style
Writing radio news

8) Writing for online media
Blog Writing
Writing for Social media
Digital story telling

Recommended Readings:
1. Richard, Communication Skills

Paper No. - MS 104

Teaching Load: 90 Practical Period

Semester |
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2. A.E.Schwartz, Communication Skills
3. Leena Sen, Communication Skills

4. John Nileson, Communication Skills
5. Juluis, Fast Body Language
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First Year

Skill component
Maximum Marks: 100
Teaching Period: 2 /week

Semester |

PHOTOGRAPHY

Paper No. — MS 105
Credits: 4
Teaching Load: 20 Practical’s/Semester

CONTENT

10.

11.

Photo camera Introduction
History

Growth

Types

DSLR camera controls and handling
Internal structure
Mechanism

Modes and Scenes:

Auto mode

Manual mode

Night mode

Working with Manual mode
ISO

Shutter

Aperture

Composition and Framing
Composition rules

Framing

Depth of field

Portrait

Types of portrait

Emotions and expression
Property use

Landscape

Foreground, Background
Golden hours

Other types of photography
Event photography

Product photography

Macro photography

Fashion photography

Travel photography
Photojournalism

Lighting

Position plays the role

Soft light Vs Hard light
Temperature: Kelvin scale
Black and white photography
Contrast

Tone

Shadow

Texture

Image processing |
Capturing
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Cropping
12. Image processing Il
Color correction
Retouching
Export
13. Employment in photography
Portfolio
Finding employment
Photography job
Visit of photo studio

Tuljaram Chaturchand College (Autonomous), Baramati. Page 37



First Year Semester |
INTRODUCTION TO MEDIA SOFTWARE
Skill component Paper No. — MS 106
Maximum Marks: 100 Credits: 4
Teaching Period: 2 /week Teaching Load: 20 Practical’s/Semester
PHOTOSHOP

1 Introduction
 Introduction to Photoshop

« Working with images
2 Basic editing
« Resizing and cropping images
« Working with basic selection
3 Layers
» Getting started with layer
» Photo retouching
4 Colour
« Adjusting to colour correction
« Mixing the photos

ILLUSTRATOR
5 Introduction
» Introduction to Hlustrator

» Draw and Transform objects
6 Basics
« Shapes and Objects
« Working with Color
7 Layers
« Working with points and path
»  Working with layers
8 Effects
» Using Illustrator effects

ADOBE AFTER EFFECTS
9 Introduction
» Introduction to Adobe After Effects

« Creating projects, compositions, and layers

10 Basics

« Creating animation for shapes, objects, and layers
» Adding and animating text

11 Special Effects

» Creating special effects using the Effects menu

* Animating Layers

12 3D work

* Introducing the Puppet Tools
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*  Working in 3D

First Year
Skill component
Maximum Marks: 100
Teaching Period: 2 /week

CONTENT

Semester |

CAMERA TECHNIQUES-I

Paper No. - MS 107
Credits: 4
Teaching Load: 20 Practical’s/Semester

1)

2)

3)

4)

5)

6)

7)

Introduction to Camera

Understanding history of image recording
Basics of camera Film and digital Cameras
Body and lens Formats of Still and videos
Basics for Camera

Functioning of auto mode of camera and Practice
Functioning of manual mode of camera and Practice

White-balance exploring manual mode
ND Filters

Camera and other accessories
Tripods handling

Camera mounting and handling with different base

Camera batteries, memory cards use and care
Other aspects of Camera
Understanding camera shots

Camera shot size

Camera movements

Camera angles

Basic operations of camera

Focus, Zoom in Zoom out

Recording with different video formats
Audio recording in camera

Spatial Continuity Rules:

Action axis, 180 degree rule.

Frame v/s Field of Vision: Lensing
The aperture: Concept, f-stops

Focus v/s Depth of Field

Field observation

Indoor field observation

Outdoor observation

Lights observation of different location
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First Year Semester 11
VISUAL COMMUNICATION

General Education Paper No. — MS 201

Maximum Marks: 100 Credits: 4

Teaching Period: 4/week Teaching Load: 60 Theory Period
CONTENT

1) Understanding Visual culture
» Elements of Visual Communication: Line, Shape, Colour and texture
» Light and form
« Depth and movement
» Visual Theories

2) Vlsual Design
Contrast: Size, symbolism, Time, Sound
» Balance, Symmetry, Rhythm
« Harmony, unity, layout, Grid
» Point of View

3) Visual Art
« Visual art History
» Painting

« Architecture and Sculpture
« Artistic Styles

4) Modes of Aesthetic Experience
« Basics of Aesthetic values
» Aesthetics of Thinking and Creativity
« Taste and Aesthetes
» Aesthetics of Symbols and Language

5) Photography and Moving Images
Historical, Technical and Cultural Perspective
+ Ethical and Critical Perspective
» Motion Pictures
» Television and Video
* Reality Shows.

6) Visual Theories
« Sensory theories of visual communication
« Gestalt Theory
» Constructivism
» Perceptual theories of visual communication
« Semiotics Theory
« Cognitive Theory

7) Visual Analysis
» Personal Perspective
« Historical Perspective
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» Technical Perspective
 Ethical Perspective

» Cultural Perspective
 Critical Perspective

Recommended Readings:

1. Paul M. (2006) Visual Communication: Images with Messages

2. Ralf E. Wileman Visual Communication

3. David Sless Learning & Visual Communication

4. The Digital Revolution: Visual Communication in the electronic age

5. Friedrich O. Huck; Carl L. Fales; Zia-Ur-Rehman. Visual Communication an Information

Theory Approach

Tuljaram Chaturchand College (Autonomous), Baramati. Page 41



First Year Semester |1
MEDIA, SOCIETY AND CULTURE
General education Paper No. - MS 202
Maximum Marks: 100 Credits: 4
Teaching Period: 4/week Teaching Load: 60 Theory Period
CONTENT

1) The Framework of Discussion about Mass Communication
» The process of mass communication
» Various issues in popular and academic discussions.
» Academic origin and concerns
*  Culture, Technology, Economy, Power and Effects
» Media as an important social institution

2) The Rise of Mass Communication
* Modernity and mass communication
* The concept of ‘mass’
+ Characteristics of mass communication
» Development of media technologies
« Mass communication without modernity and media

3) Ideas, Issues and Perspectives
» The functionalist and normative issues
« The political-economic perspectives
« Marxist view and the concept of cultural hegemony
« Information society perspective and technological influence
« Paradigm of study- Dominant and Alternative

4) Media Structure and Institution
» Features of media economy
» Competition and concentration
«  Ownership and control
» Policy issues: Freedom, Regulation, Protection, Diversity
« Public interest, economic pressures and cultural issues

5) Media Organizations in its Context
» Organization- forms and goals
» Pressure groups and dynamics of interests
« Content: Freedom and gate-keeping
» Relations with society, clients and audiences
» Professional views, dilemmas and conflicts

6) Media Content
« Content production- cultural production
« Standardization and Genres
» Issues- Bias, Representation, Commercialization
» Aesthetic of mass art
» ldeologies- modernity and post-modernity
7) Mass Audiences
« Centrality of audiences in communication discourse
» Locating audiences- society, media, content etc
« Three tradition of audience studies
» Audience behaviour- Uses and gratification
» Need to reach, know and measure audiences
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8) Media Effects
» The premise of the central concern
« Campaign and propaganda- the case of politics
» Phases of effect discourses
» Agenda setting, Cultivation, Diffusion
« ldeology and Effects

Recommended Readings:

1) Mass Communication Theory- McQuail Denis (Sage Publication)

2) Questioning the Media: Downing John et al (Sage Publication)

3) Mass Communication in India- Kumar Keval (Jaico Publication)

4) The Audiences and Its Landscape- Hay James et al (Westview Press)
5) Desperately Seeking the Audiences- Ang len (Routledge Publications)
6) www.thehoot.org

7) www.indiantelevision.com

8) www.mediadexchange.com

9) www.agencyfags.com

10) www.mediawatch.com

Tuljaram Chaturchand College (Autonomous), Baramati. Page 43


http://www.agencyfaqs.com/

First Year Semester |1
Media Research Methods

Skill component Paper No. - MS 203

Maximum Marks: 100 Credits: 4

Teaching Period: 4 /week Teaching Load: 60 Lecture/Semester
CONTENT

1. Science and Research Methods
- Different method of knowing
- Concept of research
- Nature of scientific enquiry
- Historical development of research methods
- Lessons learnt from scientific methods
2. Social Sciences and Research Methods
- Influence of scientific methods on ‘social sciences’
- Challenges to objectivity
- Theories shaping observations
- New paradigms of research
- The qualitative and the quantitative
3. Research in Communication
- Working towards ‘science of communication’
- Early methods and models
- Four stages of effect research
- Main issues of research- audience, content, effect
- Applications of research in media industry
4. Approaches to Research in Communication
- Reductionist and holistic
- Qualitative and Quantitative
- Analytical and Descriptive
- Fundamental and Applied
- One time and longitudinal
5. Elements of Research
- Variables and constants
- Hypothesis
- Concepts and constructs
- Measurements and scales
- Theories and facts
6. The Research Process-I
- The concept of research design
- Research issues
- Deciding the research topic- relevance
- Importance of theory, literature review
- Time, money and personnel
7. The Research process- 11
- Types of research design- exploratory, experimental, explanatory etc.
- Aims and objectives
- Approaches to research
- Methods of data collection
- Analysis to conclusions
8. Sampling
- Basic concept
- Representativeness

Tuljaram Chaturchand College (Autonomous), Baramati. Page 44



- Probability and non probability sample- concepts

- Types of probability and non probability samples

- Practical guidelines for sampling
9. Data Collections Methods

- Quantitative surveys

- Focus Group Discussion

- Personal Interviews

- Field Observations

- Comparative advantages and disadvantages
10. Focus on Survey and Content Analysis

- Surveys- advantages and disadvantages, types

- Questionnaire

- Uses of surveys in media industries

- Content Analysis- basic concepts, uses

- Characteristics of quantitative content analysis
11. Introduction to Statistical Analysis

- Importance of statistics in media research

- Descriptive statistics

- Correlations

- Inferential statistics- chi square, t test

- Practical examples

RecommendedReadings:

1. Mass Media Research, Roger Wimmer & Joseph Dominick

2. Mass Communication Research Methods ,HsiaH.J.

3. The Practice of Social Research, BabbieE.R.

4, Methods in Social Research, KothariC.R

5. Basics of Qualitative Research, Strauss Anselm, Corbin Juliet

6. How to Publish Communication Research, Edt-Alison Alexandretta

7. QualitativeresearchmethodsinPublicRelationsandMarketingCommunication-Daymon

Christine and Holloway Immy
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First Year

Semester 11

Camera Techniques- 11

Skill component
Maximum Marks: 150
Teaching Period: 2 /week

CONTENT
1) Controls of Camera

Exposure

Shutter

Aperture-DOF
Importance of Sensor size
White-balance

Exploring manual mode

2) Understanding lens

Introduction to lens
Different type of lens
Applications of lens
The filters

3) Recording Audio in Camcorder

Understanding Microphones
Controlling Audio in the camera
Monitoring Audio level Selecting Audio Track

4) Composition

Understanding Composition
Elements of Composition
Composition for different aspect ratio
Effect of Visual Balance

Application of Composition

Paper No. - MS 204
Credits: 6
Teaching Load:30 Practical’s/Semester

S

Composing moving image Communication through visuals

5) Lights

Revisiting Light

Basics: 6 Elements

Lighting techniques

Matching indoor and outdoor
High key and low key

Situation based lighting

Use of lighting control accessories

6) Shooting

Selecting location

Observing available light

Shooting indoor with lights
Shooting outdoor in available lights
Shooting outdoor with lights
Observing different location2
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e Different locations Shooting an interview with audio

First Year

Semester |1
Experimental Journal

Skill component Paper No. - MS 205

Maximum Marks: 150 Credits: 4

Teaching Period: 2 /week Teaching Load: 30 Practical’s/Semester
CONTENT

1)
2)
3)
4)
5)
6)
7)
8)
9)

Production of Laboratory Journal (Reporting, Editing & Page layout on computer)
Every student has to produce at least three issues under the supervision of the teacher
They need to produce a four page newspaper.

Minimum 60% content of the Experimental journal should be news based.

Preparing layout of the front, back and other pages of a newspaper

Rewrite own and local newspaper reports, articles, features regularly.

Design and layout news reports, articles and features using Page Maker or In-design

Upload experimental newspaper on available new media platforms.
Grades are based upon the effort and quality of completed work including weekly

papers, online articles and daily assignments.

10) Consistent staff participation through planning and development of all phases of

production.

11) Quality completion of individual and group assignments.

12) Weekly composite participation grade (20%)

13) Adherence to staff established deadlines (20%)

14) Quality of news and article write up (20%)

15) Section and issue development (20%)

16) Creativity and design (10%)

17) Editing (10%)

18) Each student is expected to develop five (various subjects) quality pieces throughout the

term, distributed over 3 issues. A quality piece is defined as one which is of sufficient
length and content to challenge the student. Each piece will go into the student’s
newspaper portfolio, upon which the student’s nine week grade will be evaluated.
Laying-out the paper is considered the equivalent of producing two pieces of work.
Students are expected to print out and save all of their work in their file in the classroom
and submit it.
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First Year Semester |1
Script Writing

Skill component Paper No. - MS 206

Maximum Marks: 100 Credits: 4

Teaching Period: 2 /week Teaching Load: 20 Practical’s/Semester
CONTENT

1) Writing for the Screen
e The Nature and Characteristics of Media Writing
e Literary text v/s text written for the screen
e Understanding the written word as a blue-print for visuals
e Visualization: ‘Seeing’ and ‘Hearing’ before writing

2) The Core of Screen Writing: Genesis of an Idea
e Conscious attention to surroundings/Listening carefully, reading, observing, writing a diary
regularly
e Types of Ideas: Event-led, character-based, reality-based, concept-led
e Choosing and Formulating the Theme: Choosing Characters and their Points of Views. The
Concept/ldea diary

3) Basic structure of Story

Chain of linear, chronological cause-effect event structure.

The Three Act Structure:

Beginning-middle-end(Character-Setting-Problem-Resolution)

Forming familiar associations with the written word: Short Story=short film, Novel= feature
film, Research paper/essay (with human touch) = Documentary.

e Other Parts of the Story: Character Backstories, Sub-story arcs

4) Form
e Formulating the Visual Narrative: Story+ Plot Order
e The Treatment: Plotting Scenes and Scene Flow
e Types of Narratives The First Draft and going beyond

5) Format: Fiction, Non-Fiction
e What is a Scene? What is a Unit?(Fiction v/s Non-Fiction)
e Screenplay without Dialogue: The Scene/Unit Skeletal Structure. Dialogue: Types, Rules,
Methods
e Formatting the Screenplay: Introduction to Celts /Final draft.
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First Year Semester |

VOICE MODULATION AND ANCHORING SKILLS

Skill component Paper No. - MS 207

Maximum Marks: 150 Credits: 4

Teaching Period: 2 /week Teaching Load: 30 Practical’s/Semester
CONTENT
1 The anatomy of the voice

* The lungs, rib cage

» Intercostal muscles, diaphragm

« Larynx, vocal chords

» Pharynx and other principal resonators

Breathing

» The function of the lungs, rib cage

 Intercostal muscles, diaphragm —

» Different methods of breathing and their usage —upper chest or clavicular lower chest or

abdominal method —

» whole chest or intercostal diaphragmatic method

Basics of Voice Modulation

» Pitch, pace, pause, tone quality

» Physical and Mental Fitness

» Hearing, Basics of Classical Music including the knowledge of Swara

« Vocal Health- negative effect of smoking, drugs, alcohol, the importance of good diet.
Introduction to Anchoring:

» Know your voice

» Scope for voicing, Need of anchoring

» Basics Of Anchoring.

Types of Anchoring:

» Voice over

* RJ, Anchoring

» Dubbing, Events

* Reporting, Interview.

Tips And Techniques:

* Practical’s live in our studio (mike facing),

» Introduction To Microphones, Dress Code For Men And Women
» Make-Up and other things.

»  Writing tips for Anchoring.

Quialities of Anchor :

»  Communication skill, Passion, Investigative skill, Ability to handle pressure,
» Using Social media, Leadership Skill, Humanity.

» Starting out on a positive note, Admiring the audience,

» Mingling with the audience, Having an effective speech.
Exercises for Quality Voice and Pronunciation :

»  Breathing exercises to improve volume

* Voice Exercises —Yoga and other elements

»  Methods for voice relaxation

» Lip exercises, Tongue exercises, Jaw exercises

» Extending and controlling your Pitch.

» Recording your voice and analyze

» Story reading and pronunciation

- Enhance performance on the stage and in a recording studio
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